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UNIT 2  

3D CAD – BASIC CONSTRUCTIONS FOR  MEN’S FOOTWEAR 
 

Lesson 2.1. Men’s Casual Shoe – Derby style  

Lesson 2.2. Men’s Casual Shoe –Oxford  style 

Lesson 2.3. Sport/ Training Shoe 

 

CAPITOLUL 2  

3D CAD – CONSTRUCȚII DE BAZĂ ALE ÎNCĂLȚĂMINTEI 

PENTRU BĂRBAȚI 
 

Lecția 2.1. Pantofi pentru bărbați – Stilul Derby 

Lecția 2.2. Pantofi pentru bărbați – Stilul Oxford 

Lecția 2.3. Încălțăminte  tip sport 

 

UNIDAD 2 

CAD 3D – CONSTRUCCIONES BÁSICAS DE CALZADO DE 

CABALLERO 
 

Lección 2.1. Calzado informal de caballero – Blúcher 

Lección 2.2. Calzado informal de caballero - Inglés 

Lección 2.3. Deportivo  

 

UNIDADE 2  

CAD 3D - CONSTRUÇÕES BÁSICAS DE CALÇADO DE 

HOMEM 
 

Lição 2.1. Sapato casual de homem - Blucher  

Lição 2.2. Sapato casual de homem - Inglês 

Lição 2.3. Desportivo 
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PROCESSING THE LAST 
 Select the last from data base 

 Open the last in order to edit the 3 surfaces 

 Edit the cone line 

 Edit the bottom line 

 Move the cone line  

 Calculate and mark the ball points 

 Apply front and back symmetry lines 

 Define the mesh – Step 1 (average line of the last) 

 Define the mesh – Step 2 

 Flatten the last 

 Save the flattened last 

 Save the Last in 3 surface 

 

PRELUCRAREA CALAPODULUI 
 Selectarea calapodului din baza de date 

 Deschidere calapodului în vederea editării celor 3 suprafețe 

 Editarea liniei inferioare a calapodului 

 Editarea liniei superioare a calapodului 

 Repoziționarea liniei superioare a calapodului 

 Calcularea și mutarea punctelor ce defines centrele articulațiilor metatarso-

falangiene (CAMF) I și V  

 

 

 

LESSON 2.1 

LECȚIA 2.1 / LECCIÓN 2.1 / LIÇÃO 2.1 

 
Men’s Casual Shoe – Derby style / Pantofi pentru bărbați – Stilul 

Derby / Calzado informal de caballero – Blúcher / Sapato casual de 

homem - Blucher 
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 Trasarea liniilor de simetrie anterioară și posterioară 

 Definirea rețelei calapodului – Pasul 1 (linia mediană a calapodului) 

 Definirea rețelei calapodului – Pasul 2 

 Aplatizarea calapodului 

 Salvarea calapodului aplatizat 

 Salvarea calapodului împreună cu cele 3 suprafețe 

 

PROCESAR LA HORMA 
 Seleccionar la horma de la base de datos 

 Abrir la horma para editar las 3 superficies 

 Editar la línea de planta 

 Editar la línea de lupe 

 Bajar la línea de lupe 

 Calcular y marcar los puntos de ball 

 Aplicar las líneas de simetría anterior y posterior 

 Definir la malla – Paso 1 (línea media de la horma) 

 Definir la malla – Paso 2 

 Aplanar la horma 

 Guardar la horma aplanada 

Guardar la horma en 3 superficies 

 

PROCESSAMENTO DA FORMA 
 Selecionar a forma a partir da base de dados 

 Abrir a forma para editar as três superfícies 

 Editar as linhas da planta e do topo 

 Baixar a linha do topo 

 Calcular e marcar os pontos de ball 

 Aplicar as linhas de simetria anterior e posterior 

 Definir a malha - Passo 1 (linha média da forma) 

 Definir a malha - Passo 2 

 Achatar a forma 

 Guardar a forma achatada 

 Guardar a forma em 3D 
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Select the last from data base 

Choose the last from data base and define its 3 surfaces for being further recognized as a solid. When you 

press left click on the name of the last, it could be seen in 3 views window on right side of the screen. Right 

click on the name of the last and select  the “Create a last in 3 surfaces” option. 

Selectarea calapodului din baza de date 

Se alege calapodul din baza de date și se definesc cele trei suprafețe ale acestuia pentru a fi recunoscut ca și 

solid. Atunci când se apasă click stânga pe numele calapodului, acesta poate fi vizualizat în 3 vederi, în 

fereastra din dreapta ecranului. Pentru a putea prelucra mai departe calapodul se apasă click dreapta pe 

numele acestuia și se alege opțiunea “Create a last in 3 surfaces”. 

Seleccionar la horma de la base de datos 

El primer paso es seleccionar una horma de la base de datos y definir sus 3 superficies para que el sistema la 

reconozca como un objeto sólido. Para ello,  pinchar con el botón izquierdo sobre el nombre de la horma 

para verla en una ventana con 3 vistas a la derecha. Pinchar con el botón derecho sobre el nombre de la 

horma y seleccionar “Create a last in 3 surfaces/Crear horma en 3 superficies”. 

Selecionar a forma a partir da base de dados 

O primeiro passo consiste em selecionar a forma a partir da base de dados. Será necessário definir as suas 3 

superfícies de modo a que o sistema a reconheça como um objeto sólido. Para fazer isso clique com o botão 

esquerdo do rato sobre o nome da forma e irá visualizá-la numa janela com três vistas do lado direito do 

ecrã. Depois clique com o botão direito do rato sobre o nome da forma e selecione a opção "Create a last in 3 

surfaces/Criar a forma em 3 superfícies”. 
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Open the last in order to edit the 3 surfaces 

For editing the three surfaces of the selected last a different menu of Icad 3D+ is automatically opened. 

Deschiderea calapodului în vederea editării celor 3 suprafețe 

Pentru editarea celor 3 suprafețe ale calapodului selectat, se deschide automat o nouă fereastră a aplicației 

Icad 3D+ după alegerea opțiunii “Create a last in 3 surfaces”. 

Abrir la horma para editar las 3 superficies 

Para editar las 3 superficies de la horma seleccionada, se abre un menú diferente de Icad3D+. 

Abrir a forma para editar as três superfícies 

Para editar as 3 superfícies da forma selecionada, irá abrir-se um menu diferente do programa Icad3D+. 

 

 
 

Note: 
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Edit the cone and bottom lines 

For editing cone and bottom lines, select one of the lines with left click and press “Node mode”. Move the 

points until the line fits with the bottom edge of the last.  

Editarea liniilor superioare și inferioare ale calapodului 

Pentru editarea liniei superioare și a liniei inferioare ale calapodului, se selectează cu click stânga una dintre 

linii după care se lansează comanda “Node mode”. Punctele sunt repoziționate astfel încât linia care 

formează conturul inferior/superior să corespundă muchiei superioare/inferioare a  calapodului. 

Editar la línea de lupe y de planta 

Para editar las las líneas de planta y de lupe, se seleccionan las líneas con el botón izquierdo y se pulsa 

“Nodemode/Modo nodo”. Mover los puntos de la línea hasta que se correspondan con el canto de la horma. 

Editar as linhas da planta e do topo 

Para editar as linhas da planta e do topo clique com o botão esquerdo do rato para seleccionar a linha e 

depois pressione “Node mode / Modo nó”. Mova os pontos da linha para fazer corresponder com a borda 

da forma. 

 

 
 

Note: 
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Move the cone line 

For transforming the last into a solid one, move the upper edge line down, at least 2 mm. Select the line and 

then press the button “go down curve”, not before entering the distance value inside the box. In this stage, 

correct the heel height and toe height. 

Repoziționarea liniei superioare a calapodului 

Pentru a obține o copie medie cât mai corectă, linia superioară a calapodului este coborâtă cu 2 mm. După 

selectarea liniei superioare se poate lansa comanda “go down curve”, nu înainte de a introduce valoare 

distanței în căsuța alăturată. În această etapă se corectează și înălțimea tocului și a vârfului. 

Bajar la línea de lupe 

Para transformar la horma en un objeto sólido, es necesario bajar la línea del borde superior al menos 2 mm. 

Para ello, se selecciona la línea, se introduce la distancia en la casilla de la derecha, y se pincha en “Godown 

curve/Bajar curva”. También es importante corregir la altura de talón y la salida de punta. 

Baixar a linha do topo 

Para transformar a forma num objeto sólido é necessário baixar a linha do bordo superior em pelo menos 2 

mm. Para fazer isso selecione a linha, introduza o valor da distância na caixa à direita e clique no botão “Go 

down curve/Baixar a curva”. É também importante corrigir a altura do calcanhar e da biqueira. 

 

 
 

Note: 
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Calculate and mark the ball points 

In order to define the ball line, the ball points have to be marked. The software automatically calculates the 

position of these points by selecting “Calculate ball” from “Tools” menu, and it allows you to manually 

change the position of the points. 

Calcularea și marcarea punctelor ce definesc centrele articulațiilor metatarso-falangiene (CAMF) I și V 

Pentru definirea liniei degetelor, trebuiesc marcate punctele CAMF (punctele ce definesc centrele 

articulațiilor metatarso-falangiene I și V). Aplicația software marchează în mod automat aceste puncte prin 

selectarea opțiunii “Calculate ball”din meniul “Tools”, dar permite de asemenea modificarea de către 

utilizator a poziției acestora. 

Calcular y marcar los puntos de ball 

Para definir la línea de ball es necesario definir los puntos de ball. El software marca automáticamente estos 

puntos, seleccionando Calculate ball/Cálculo automático de ball del menú de herramientas. Se podrá 

modificar la posición de los puntos manualmente. 

Calcular e marcar os pontos de ball 

Para definir a linha de ball, é necessário definir os pontos de ball. O software marca automaticamente estes 

pontos, mas permite a sua modificação. Para isso aceda a “Tools menu > Calculate ball / Menu Ferramentas 

> Calcular ball”. 

 

 
 

Note: 
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Apply front and back symmetry lines 

first press “Initial positioning” and after that press “Repositioning”.  

Trasarea liniilor de simetrie anterioară și posterioară 

Se poziționează în mod corect calapodul prin selectarea opțiunii “Initial positioning” după care sunt trasate 

liniile de simetrie selectând comanda “Repositioning”. 

Aplicar las líneas de simetría anterior y posterior 

Para posicionar la horma correctamente, pinchar en “Initialpositioning/Posicionamiento inicial” y a 

continuación pinchar en “Repositioning/ Reposicionamiento”. 

Aplicar as linhas de simetria anterior e posterior 

Para posicionar corretamente a forma, clique em "Initial positioning / Posicionamento inicial” e para 

modificar as linhas de simetria anterior e posterior clique em "Repositioning / Reposicionamento”. 

 

 
 

Note: 
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Define the mesh – Step 1 (average line of the last) 

By pressing “Step 1” the software will create the average line, which it is placed between the cone line and 

the bottom line. Based on this line, the software will create the mesh. 

Definirea rețelei calapodului– Pasul 1 (linia mediană) 

Prin selectarea comenzii ”Step 1”, aplicația definește automat o linie mediană plasată între linia superioară și 

linia inferioară a calapodului. În funcție de forma și poziționarea acestei linii, aplicația va genera automat 

rețeaua calapodului. 

Definir la malla – Paso 1 (línea media de la horma) 

Al pinchar sobre “Step 1/Paso 1” el software crea la línea media de la horma, que se sitúa entre la línea de 

lupe y la línea de planta. Basadoenestalínea, el software creará la malla.  

Definir a malha - Passo 1 (linha média da forma) 

Ao clicar em “Step 1 / Passo 1” o software cria a linha média da forma, que se situa entre a linha da planta e 

a linha do topo. Com base nesta linha o software irá depois criar a malha.  

 

 
 

Note: 
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Define the mesh – Step 2 

The previous line becomes a reference line for the mesh that will be created. Press “Step 2”  and the mesh  is 

automatically  placed on the last. 

Definirea rețele icalapodului– Pasul 2 

Pentru generarea automată a rețelei calapodului se selectează opțiunea ”Step 2”. 

Definir la malla – Paso 2 

La línea anterior se convierte en la línea de referencia para crear la malla. Pinchar en “Step 2/Paso 2”  y la 

malla se generará automáticamente sobre la horma. 

Definir a malha - Passo 2 

A linha anterior torna-se a linha de referência para criar a malha. Clique em ”Step 2 / Passo 2” e a malha será 

gerada automaticamente na forma. 

 

 
 

Note: 
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Flatten the last 

The next step is to flatten the last by pressing “Last Flattening” .  

Another window is opened where you could see the inside and the outside flattened surfaces of the last. 

Aplatizarea calapodului 

Pentru aplatizarea calapodului se selectează “Last Flattening”.  

Se deschide automat o nouă fereastră unde pot fi vizualizate cele două suprafețe aplatizate ale calapodului, 

suprafața interioară și suprafața exterioară. 

Aplanar la horma 

Con el botón izquierdo, pinchar sobre “Lastflattening/Horma aplanada” .  

Se abrirá otra ventana en la que se muestra el lado interior y el exterior aplanados de la horma. 

Achatar a forma 

Com o botão esquerdo do rato clique em "Last Flattening / Achatamento da forma”.  

Uma outra janela irá abrir-se onde poderá visualizar as partes interior e exterior da forma.  
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Save the flattened last 

If you agree with the shape obtained, the flattened last will be saved. Go to File>Save As>, choose location 

and name the new last. 

Salvarea calapodului aplatizat 

Dacă forma obținută este corespunzătoare, calapodul aplatizat va fi salvat urmărind succesiunea File>Save 

As>, fiind introduse locația unde va fi salvat și numele acestuia. 

Guardar la horma aplanada 

Si la horma obtenida es satisfactoria, se puede guardar el aplanado mediante File>Save 

As/Archivo>Guardar como> escogiendo la ruta y nombre del archivo.  

Guardar a forma achatada 

Se a forma achatada obtida é satisfatória poderá guardá-la em ”File>Save As / Ficheiro> Guardar como”  

escolhendo o caminho e o nome do arquivo.  

 

 
 

Note: 
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Save the Last in 3 surface 

After you save the flattened last, go back to last in 3 surfaces, by pressing “Exit”   

Here also save the last, File>Save As>, choose the location and name the last.  

Salvarea calapodului 3D 

După ce se salvează calapodul aplatizat, utilizatorul se poate întoarce în fereastra anterioară prin click stânga 

pe “Exit”   

Urmărind succesiunea File>Save As>, se va salva calapodul 3D, fiind introduse locația unde va fi salvat și 

numele acestuia. 

Guardar la horma en 3 superficies 

Tras guardar la horma aplanada, regresar a la horma en 3 superficies pinchando en       “Exit/Salir”         

 
Guardar la horma con File>Save As/Archivo>Guardar como escogiendo la ruta y nombre del archivo.  

Guardar a forma em 3D 

Depois de guardar a forma achatada, volte à forma em três superfícies clicando em ”Exit / Sair”.  

Guarde a forma em ”File>Save As / Ficheiro>Guardar como” escolhendo o caminho e o nome do arquivo.  

 

 
 

Note: 
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3D MODELLING OF UPPERS 

FOR MEN’S SHOE   

 
 Open the last for creating a new model 

 Draw design lines 

 Define and apply margins 

 Mirror model lines  

 Create pieces 

o Piece Group 

o Piece Groups management 

o Selecting the lines of the piece 

o Create model pieces 

 Stitches 

o Define stitches 

o Apply stitches to pieces 

 Edit pieces 

o Offset and thickness 

o Define the edge type 

 Apply colours and textures to pieces 

 Create lace holes 

o Define element properties 

o Add element 

 Add shoe laces 

MODELAREA 3D A 

ANSAMBLULUI SUPERIOR  

 
 Selectarea calapodului pentru 

proiectarea unui nou model 

 Trasarea liniilor de model 

 Definirea și aplicarea marginilor 

 Oglindirea liniilor de model 

 Obținerea tiparelor 

o Definirea grupurilor de tipare 

o Gestionarea grupurilor de tipare 

o Selectarea linilor care definesc 

tiparele 

o Obținerea tiparelor modelului 

 Aplicarea cusăturilor 

o Definirea cusăturilor 

o Aplicarea cusăturilor pe tipare 

 Editarea tiparelor 

o Definirea distanței față de 

calapod și a grosimii 

o Definirea tipurilor de margini 

 Aplicarea culorilor și a texturilor pe 

tipare 

 Obținerea perforațiilor de înșiretare 

o Definirea caracteristicilor 

perforațiilor 

o Aplicarea perforațiilor 

 Definirea și aplicarea șireturilor 
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MODELADO EN 3D DEL 

CORTE DE UN ZAPATO DE 

CABALLERO 

 
 Abrir la horma para crear un nuevo 

modelo 

 Dibujar las líneas de diseño 

 Definir y aplicar los márgenes 

 Copiar las líneas del lado exterior sobre 

el lado interior de la horma 

 Crear piezas 

o Grupos de piezas 

o Gestión de grupos de piezas  

o Seleccionar las líneas de la pieza 

o Crear las piezas del modelo  

 Cosidos 

o Definir cosidos 

o Aplicar cosidos a las piezas 

 Editar piezas 

o Offset y espesor 

o Definir tipo de canto 

 Aplicar colores y texturas a las piezas 

 Crear cordones 

o Definir propiedades de elemento 

o Añadir elemento 

 Añadir cordones 

MODELAGEM EM 3D DO 

CORTE DE UM SAPATO DE 

HOMEM 

 
 Abrir a forma para criar um novo 

modelo 

 Desenhar as linhas de design 

 Definir e aplicar as margens 

 Copiar as linhas do modelo 

 Criar peças 

o Definir grupos de peças 

o Gerir grupos de peças  

o Selecionar as linhas da peça 

o Criar as peças do modelo  

 Costuras 

o Definir as costuras 

o Aplicar as costuras às peças 

 Editar as peças 

o Offset e espessura 

o Definir tipos de bordas 

 Aplicar cores e texturas às peças 

 Criar ilhós 

o Definir propriedades dos 

elementos 

o Adicionar elementos 

 Adicionar atacadores 
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Open the last for creating a new model 

Now, the last could be used for creating a shoe model on it. Go back to the main window, go to “Flattened 

lasts”. With left click select the last, right click on its name and select “New model”. 

Selectarea calapodului pentru proiectarea unui nou model 

În acest moment, calapodul este pregătit pentru a fi folosit la crearea unui model de încălțăminte. 

Utilizatorul va merge la secțiunea “Flattened lasts”, din meniul principal, unde cu click stânga va selecta 

calapodul definit anterior și cu click dreapta pe numele acestuia va selecta “New model”, pentru a crea un 

nou model. 

Abrir la horma para crear un nuevo modelo 

Ahora se puede utilizar la horma para crear el modelo sobre ella. Para ello, regresar a la ventana principal 

del software, e ir a "Flattenedlast/Horma aplanada". Pinchar con el botón izquierdo para seleccionar la 

horma, y pinchar con el botón derecho sobre el nombre de la horma. Luego, seleccionar “New model/Nuevo 

modelo”. 

Abrir a forma para criar um novo modelo 

Pode agora usar a forma para criar o modelo sobre esta. Para isso volte à janela principal do programa, aceda 

a "Flattened last / Forma achatada". Clique com o botão esquerdo do rato sobre a forma criada 

anteriormente, e clique com o botão direito sobre o nome da forma. De seguida selecione "New model / 

Novo modelo". 

 

 
 

Note: 
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Open the last for creating a new model 

A new window will be opened, where you can create lines, pieces, margins, stitches, accessories, sole, insole, 

heel. 

Selectarea calapodului pentru proiectarea unui nou model 

După selectarea comenzii “New model” se deschide automat o nouă fereastră unde pot fi create linii, tipare, 

margini, cusături, accesorii, branțuri, tălpi, tocuri. 

Abrir la horma para crear un nuevo modelo 

Se abrirá una nueva ventana en la que se pueden crear líneas, piezas, márgenes, cosidos, accesorios, suelas, 

plantillas, tacones, etc.  

Abrir a forma para criar um novo modelo 

Irá abrir-se uma nova janela onde poderá criar linhas, peças, margens, costuras, acessórios, solas, palmilhas, 

tacões, etc. 

 

 
 

Note: 
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Draw design lines - toe line 

First line to be created for this model is the toe line. Select “Shell” to open the menu, then select “create 

ibspline”. Place one point after another with left click,  and draw the  toe line. 

After the line is created, you could both edit and correct it by using “Node mode”.  

Trasarea liniilor de model – linia degetelor 

Prima linie ce va fi creată pentru acest model este linia degetelor. Se selectează butonul “Shell” pentru a 

deschide meniul corespunzător, după care, cu click stânga se alege “create ibspline”. Cu click stânga se 

aplică pe calapod punct după punct, până când se obține întreaga linie. 

După crearea liniei, aceasta poate fi editată și corectată utilizând funcția “Node mode”. 

Dibujar las líneas de diseño – Línea de punta 

La primera línea a crear para este modelo es la línea de punta. Seleccionar “Shell/Trepa” para abrir el menú, 

y seleccionar “Createibspline/curva”. Colocar un punto tras otro con el botón izquierdo del ratón, y dibujar 

la línea de punta.  

Tras crear la línea, se puede editar y corregir con el icono “Nodemode/Modo nodo”.  

Desenhar as linhas de design – linha da ponta 

A primeira linha a criar neste modelo é a linha da ponta. Para isso selecione "Shell” para abrir o menu, 

clique com o botão esquerdo do rato e selecione "Criar ibspline / Curva". Ao clicar com o botão esquerdo, ir 

colocando ponto atrás de ponto e desenhar a linha. 

Depois de criar a linha, poderá edita-la e corrigi-la. Para isso selecione a linha com o botão esquerdo do rato, 

clique em “Node Mode / Modo nó”. 

 

 
 

Note: 
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Draw design lines - toe line 

For drawing a parallel line to the toe line, go to “Margins” tab, select offset distance (10 mm in this case), left 

click on the toe line and drag the cursor to the left.  

Trasarea liniilor de model – linia degetelor 

În cazul acestui model este necesară trasarea unei linii paralele cu linia degetelor, la o distanță de 10 mm, 

utilizând funcțiile meniului ”Margins”. După introducerea distanței, este selectată linia degetelor cu click 

stânga care este ținut apăsat în timp ce cursorul este mișcat spre partea posterioară a calapodului. Pentru 

obținerea liniei paralele se dă drumul cursorului. 

Dibujar las líneas de diseño – Línea de punta 

Para dibujar una línea paralela a la lína de punta, ir a la pestaña “Margins/Márgenes”, seleccionar la 

distancia de offset (10 mm en este caso), clicar con el botón izquierdo sobre la línea y arrastrar el cursor a la 

izquierda. 

Desenhar a linhas de design – linha da ponta 

Para desenhar uma linha paralela à linha da ponta, aceda ao separador "Margins / Margens", selecione a 

distância de offset (10 mm, neste caso), clique com o botão esquerdo do rato sobre a linha e arraste o cursor 

para a esquerda. 

 

 
 

Note: 
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Draw design lines - upper quarter line 

Follow the same steps (slide 22) for drawing  and editing the quarter line. 

Trasarea liniilor de model – linia superioară a carâmbului 

Pentru trasarea și editarea marginii superioare a carâmbului este urmărit modul de lucru prezentat anterior. 

Dibujar las líneas de diseño – Línea trasera superior 

Seguir los mismos pasos (diapositiva 22) para dibujar y editar la línea trasera. 

Desenhar as linhas de design - Linha traseira superior 

Execute os mesmos passos acima (slide 22) para desenhar e editar a linha traseira. 

 

 
 

Note: 

 

 

 

 

 

 

 

 
  



UNIT 2 / CAPITOLUL 2 / UNIDAD 2 / UNIDADE 1 
 

 
164 

 

Draw design lines - instep line 

Follow the same steps (slide 22) for drawing  and editing the instep line. 

Trasarea liniilor de model – linia auxiliară a ristului 

Pentru trasarea și editarea liniei auxiliare a ristului este urmărit modul de lucru prezentat anterior. 

Dibujar las líneas de diseño – Línea de empeine 

Seguir los mismos pasos (diapositiva 22) para dibujar y editar la línea de empeine. 

Desenhar as linhas de design - linha do peito do pé 

Execute os mesmos passos acima (slide 22) para desenhar e editar a linha do peito do pé. 

 

 
 

Note: 
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Draw design lines - quarter line 

Follow the same steps (slide 22) for drawing and editing the quarter line. 

Trasarea liniilor de model –carâmbul 

Pentru trasarea și editarea liniei carâmbului este urmărit modul de lucru prezentat anterior. 

Dibujar las líneas de diseño – Línea trasera 

Seguir los mismos pasos (diapositiva 22) para dibujar y editar la línea trasera. 

Desenhar as linhas de design - linha traseira 

Execute os mesmos passos acima (slide 22) para desenhar e editar a linha traseira. 

 

 
 

Note: 
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Draw design lines – tip toe line 

Follow the same steps (slide 22) for drawing and editing the tip toe line. 

Trasarea liniilor de model– vârful 

Pentru trasarea și editarea liniei vârfului este urmărit modul de lucru prezentat anterior. 

Dibujar las líneas de diseño – Línea de puntera 

Seguir los mismos pasos (diapositiva 22) para dibujar y editar la línea de puntera. 

Desenhar as linhas de design - linha da biqueira 

Execute os mesmos passos acima (slide 22) para desenhar e editar a linha da biqueira. 

 

 
 

Note: 
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Draw design lines - counter line 

Follow the same steps (slide 22) for drawing and editing the counter line. 

Trasarea liniilor de model –ștaiful 

Pentru trasarea și editarea liniei ștaifului este urmărit modul de lucru prezentat. 

Dibujar las líneas de diseño – Línea de talón 

Seguir los mismos pasos (diapositiva 22) para dibujar y editar la línea de talón. 

Desenhar as linhas de design – linha da taloeira 

Execute os mesmos passos acima (slide 22) para desenhar e editar a linha da taloeira. 

 

 
 

Note: 
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Draw design lines - vamp line 

Follow the same steps (slide 22) for drawing  and editing the vamp line. 

Trasarea liniilor de model –căputa 

Pentru trasarea și editarea liniei căputei este urmărit modul de lucru prezentat anterior. 

Dibujar las líneas de diseño – Línea de pala 

Seguir los mismos pasos (diapositiva 22) para dibujar y editar la línea de pala. 

Desenhar as linhas de design – linha da gáspea 

Execute os mesmos passos acima (slide 22) para desenhar e editar a linha da gáspea. 

 

 
 

Note: 
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Draw design lines - tongue line 

Follow the same steps (slide 22) for drawing  and editing the tongue line. 

Trasarea liniilor de model –limba 

Pentru trasarea și editarea liniei limbii este urmărit modul de lucru prezentat anterior. 

Dibujar las líneas de diseño – Línea de lengüeta 

Seguir los mismos pasos (diapositiva 22) para dibujar y editar la línea de lengüeta. 

Desenhar as linhas de design – linha da língua 

Execute os mesmos passos acima (slide 22) para desenhar e editar a linha da língua. 

 

 
 

Note: 
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Draw design lines - lace holes line 

Follow the same steps (slide 22) for drawing and editing the lace holes line line. 

Trasarea liniilor de model - linia orificiilor de înșiretare 

Pentru trasarea și editarea liniei orificiilor de înșiretare este urmărit modul de lucru prezentat anterior. 

Dibujar las líneas de diseño – Líneas de ojetes 

Seguir los mismos pasos (diapositiva 22) para dibujar y editar la línea de ojetes. 

Desenhar as linhas de design – linha dos ilhós 

Execute os mesmos passos acima (slide 22) para desenhar e editar a linha dos ilhós. 

 

 
 

Note: 
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Define and apply margins 

The sewing allowances will be defined as margins to pieces depending on the relations between pieces. For 

that, go to margins menu and select the needed distance from the list or double click on “Not predefined” 

and introduce the required distance. To apply the margins, select the line and drag it on the left or right side 

as the piece will be, under or on the top. 

Definirea și aplicarea marginilor 

Rezervele de coasere vor fi definite ca margini pentru tipare în funcție de modul de îmbinare al reperelor 

între ele. Pentru a defini o margine, se alege meniul ”Margins”, după care se face dublu click pe “Not 

predefined” și se introduce distanța dorită. Pentru a aplica marginile, se selectează linia și se mută în 

dreapta sau în stânga, în funcție de poziția tiparului, deasupra sau dedesubt. 

Definir y aplicar los márgenes 

Se definen los márgenes de cosido como márgenes de las piezas, en función de la relación entre piezas. Para 

ello, ir al menú de márgenes, introducir la distancia necesaria de la lista o hacer doble click sobre “Not 

predefined/No predefinido” e introducir la distancia necesaria. Para aplicar los márgenes, seleccionar la 

línea y arrastrarla hacia la derecha o la izquierda, por encima o por debajo. 

Definir e aplicar as margens 

Definem-se as margens das costuras como margens das peças, dependendo da relação entre as peças. Para 

isso aceda ao menu de margens, indique a distância desejada a partir da lista ou clique duas vezes sobre 

“Not predifined / Não predefinido" e introduza a distância necessária. Para aplicar as margens selecione a 

linha e arraste-a para a direita ou para a esquerda, para cima ou para baixo.  
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Mirror the model lines 

For mirroring the lines drawn on the outside part of the last, go to “Symmetry” tab,  select with left click the 

“Main axis” (represented by the front and back central lines of the last). Go to the model line, left click on 

this line and it will be mirrored on the inside part of the last.  

Oglindirea liniilor de model exterioare pe partea interioară a calapodului 

Pentru oglindirea liniilor de model se selectează opțiunea “Main axis”, din meniul ”Symmetry”. Cu click 

stânga se selectează una câte una liniile de model, acestea fiind oglindite automat pe partea interioară a 

calapodului. 

Copiar las líneas del modelo 

Para copiar las líneas dibujadas sobre el lado exterior de la horma, ir a la pestaña "Symmetry/Simetría", 

seleccionar con el botón izquierdo “Main axis/Eje principal” (representado porla línea central frontal de la 

horma). Con el botón izquierdo, seleccionar cada línea que se desea copiar sobre el lado interior de la horma. 

Copiar as linhas do modelo 

Para copiar as linhas do lado exterior sobre o lado interior da forma, aceda ao separador "Symmetry / 

Simetria" e selecione com o botão esquerdo do rato “Main axis / Eixo principal" que é a linha central da 

frente da forma. Com o botão esquerdo do rato, selecione cada linha a ser copiada para o interior da forma.  

 

 
 

Note: 
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Create pieces – Piece group 

Go to “Pieces” menu. First step is to define the name of the piece group, double left click on “GRUPO1” and 

a new window is opened where you can enter the new name for the group, “Uppers” in this case.  

Obținerea tiparelor – Definirea grupurilor de tipare 

Primul pas în vederea obținerii tiparelor este denumirea grupurilor de repere. În meniul ”Pieces”,se apasă 

dublu click stânga pe “GRUPO1”și se introduce numele dorit (“Uppers”) în fereastra nou deschisă. 

Crear piezas – Grupo de piezas 

Ir al menú “Pieces/Piezas”. El primer paso es definir el nombre del grupo de piezas. Hacer doble clic con el 

botón izquierdo en “GRUPO1” y se abrirá una nueva ventana en la que se puede introducir un nuevo 

nombre para el grupo, en este caso “Uppers/Cortes”.  

Criar peças – definir grupos de peças 

Aceda ao menu "Pieces / Peças". O primeiro passo consiste em definir o nome do grupo de peças. Clique 

duas vezes com o botão esquerdo do rato em "GRUPO 1" e irá abrir-se uma janela na qual poderá digitar um 

novo nome para o grupo, neste caso “Uppers / Cortes". 

 

 
 

Note: 
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Create pieces – Groups management 

Second step is to erase the unnecessary groups. Press left click on “Groups management” button, select the 

group name from the newly opened window, and press “delete”. 

Obținerea tiparelor – Gestionarea grupurilor de tipare 

Al 2-lea pas este reprezentat de eliminarea grupurilor de repere neutilizate. Este selectat butonul “Groups 

management”, în fereastra nou deschisă putând fi accesate comenzile de gestionare a grupurilor de tipare. 

Crear piezas – Gestión de grupos 

El segundo paso consiste en eliminar los grupos innecesarios. Pinchar con el botón izquierdo en el botón 

“Groupsmanagement/Gestión de grupos”, seleccionar el nombre del grupo en la ventana que se abre, y 

clicar en “delete/eliminar”. 

Criar peças – gerir grupos de peças 

O segundo passo consiste em remover grupos desnecessários. Clique com o botão esquerdo do rato sobre o 

botão “Groups management / Gestão de grupos", selecione o nome do grupo na janela que se irá abrir e 

clique em “Delete / Apagar". 

 

 
 

Note: 
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Create pieces - Selecting the lines of the piece 

For defining the pieces, press “Manual creation of piece”  and, with left click, select each line of the piece. 

Obținerea tiparelor - Selectarea liniilor 

Pentru definirea tiparelor, este utilizată opțiunea “Manual creation of pieces”. Liniile care reprezintă 

marginile tiparului sunt selectate cu click stânga. 

Crear piezas – Seleccionar las líneas de la pieza 

Para definir la pieza, pinchar en “Manual creation of piece/Creación manual de pieza”  y con el botón 

izquierdo seleccionar cada línea de la pieza.  

Criar peças - selecionar as linhas das peças 

Para definir a peça clique em "Manual creation of piece / Criação manual de peças"  e com o botão esquerdo 

selecione cada linha da peça.  

 

 

 
 

Note: 
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Create pieces - tip toe 

When all lines of a piece are selected, press right click and the software automatically creates the piece with 

the predefined colour. After creating the piece, you can change the name by double click on “Piece 1” and 

enter the name that you want; in this case it is “tip toe”. 

Obținerea tiparelor–vârful 

După selectarea tuturor liniilor, se apasă click dreapta, tiparul dorit fiind creat automat. După obținerea 

tiparului, se poate modifica numele acestuia, prin dublu click pe “Piece 1” (nume atribuit automat tiparului 

nou creat). Se deschide o nouă fereastră în care este introdus numele tiparului, de exemplu “tip toe” (vârf). 

Crear piezas – Puntera 

Cuando se hayan seleccionado todas las líneas de la pieza, pinchar con el botón derecho y el software creará 

automáticamente la pieza con un color predefinido. Después de crear la pieza, se puede cambiar el nombre 

haciendo doble clic sobre “Piece 1/Pieza 1” e introduciendo el nombre deseado, en este caso “tip toe”. 

Criar peças - biqueira 

Quando tiver selecionado todas as linhas da peça, clique com o botão direito do rato e o programa irá 

automaticamente criar a peça com uma cor predefinida. Depois de criar a peça poderá alterar o nome 

clicando duas vezes sobre "Piece 1 / Peça 1“ e introduzindo o nome pretendido, neste caso “biqueira". 
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Create pieces - vamp and tongue 

All the pieces will be created by following the steps presented before. 

Obținerea tiparelor - căputa și limba 

Urmărind pașii prezentați anterior vor fi definite toate tiparele. 

Crear piezas – Pala y lengüeta 

Se crean todas las piezas siguiendo los pasos descritos anteriormente.  

Criar peças – gáspea e língua 

Para criar estas peças execute os mesmos passos descritos acima.  

 

 
 

Note: 
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Create pieces - vamp and tongue 

All the pieces will be created by following the steps presented before. 

Obținerea tiparelor - căputa și limba 

Urmărind pașii prezentați anterior vor fi definite toate tiparele. 

Crear piezas – Pala y lengüeta 

Se crean todas las piezas siguiendo los pasos descritos anteriormente.  

Criar peças - parte traseira e taloeira 

Para criar estas peças execute os mesmos passos descritos acima. 

 

 
 

Note: 
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Stitches - Define stitches 

To define a new stitch, from “Pieces” window select “Stitches” tab, left click on “Add sewing type” button 

and a window called “Sewing properties” is opened. Here you can define stitch name, type, style, distance 

between stitches, stitches angle, distances between needles, elements in group, separation between group, 

length, height, width and colours. 

Definirea cusăturilor 

Pentru definirea unei noi cusături, din meniul “Pieces”, fereastra “Stitches”,se selectează “Add sewing 

type”, acțiune care conduce la deschiderea automată a ferestrei “Sewing properties”. În această fereastră pot 

fi definite numele și tipul cusăturii, pasul cusăturii, unghiul de înclinare al cusăturii, grupurile de cusături, 

lungimea, înălțimea, lățimea și culoarea cusăturii. După apăsarea butonului ”ok” este definit un nou tip de 

cusătură. 

Cosidos – Definir cosidos 

Para definir un nuevo cosido, desde la ventana “Pieces/Piezas”, seleccionar la pestaña “Stitches/Cosidos”. 

Pinchar con el botón izquierdo en el botón “Addsewingtype/Añadir tipo de cosido” y se abrirá una nueva 

ventana llamada “Sewingproperties/Propiedades del cosido”. Aquí si puede definir el nombre del cosido, 

el tipo, el estilo, la distancia entre puntadas, el ángulo de las puntadas, la distancia entre agujas, los 

elementos en grupo, la separación entre grupos, la longitud, la altura, la anchura y los colores.  

Costuras – Definir as costuras 

Para definir uma nova costura aceda à janela "Pieces / Peças“ e selecione "Stitches/Costuras". Clique com o 

botão esquerdo do rato sobre o botão "Add sewing type / Adicionar tipo de costura“ e irá abrir-se uma nova 

janela chamada "Sewing properties / Propriedades da costura". Aqui pode definir o nome da costura, tipo, 

estilo, a distância entre pontos, o ângulo dos pontos, a distância entre as agulhas, os elementos de um grupo, 

a separação entre grupos, comprimento, altura, largura e cores.  
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Stitches - Apply stitches to pieces 

Select the new defined stitch type, select the piece, and with left click select the line were you want to apply 

the stitch. Press right click and the stitch will be marked. 

Aplicarea cusăturilor 

Se selectează cusătura nou creată, se selectează tiparul pe care se dorește aplicarea cusăturii și cu click stânga 

se alege marginea tiparului pe care va fi aplicată cusătura. Cusătura este aplicată automat pe tipar atunci 

când este apăsat click dreapta. 

Cosidos – Aplicar cosidos a las piezas 

Seleccionar el nuevo tipo de cosido definido, seleccionar la pieza, y con el botón izquierdo seleccionar la 

línea en la que se desea aplicar el cosido. Pinchar con el botón derecho y se marcará el cosido. 

Costuras - Aplicar as costuras às peças 

Selecione o novo tipo de costura definido, clique com o botão esquerdo do rato sobre a linha na qual deseja 

colocar a costura, e clique com o botão direito para aplicar a costura.  

 

 
 

Note: 
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Edit pieces - offset and the thickness 

You can change the offset of your piece, which means the distance from last to piece. This modification has 

to be done when you want to show which piece is over/up and which one is under/down. The thickness has 

to be correlated with the material you are using. For this modification, select the piece name and fill in the 

certain values for offset and thickness. These settings can be made when each piece is defined, or at the end, 

for the entire model. 

Editarea tiparelor – Definirea distanței față de calapod și a grosimii 

Modificarea distanței tiparului față de calapod este necesară atunci când se dorește evidențierea poziției 

tiparelor în structura produsului. Grosimea tiparului trebuie corelată cu grosimea materialului. Se selectează 

numele tiparului și se introduc valorile specifice distanței față de calapod (Offset) și a grosimii materialului 

(Thickness). 

Editar piezas - Offset y espesor 

Se puede cambiar el espesor de la pieza, es decir, la distancia desde la horma hasta la pieza. Esta 

modificación debe realizarse cuando se desea mostrar qué pieza si sitúa por encima y qué pieza se sitúa por 

debajo. El espesor debe guardar relación con el material utilizado. Para realizar este cambio, seleccionar la 

pieza e introducir los valores de offset y espesor. Estos parámetros se pueden fijar cuando se define la pieza 

o al final, para todo el modelo.  

Editar  as peças - Offset e espessura 

É possível alterar o offset da peça, ou seja, a distância entre a forma e a peça. Esta operação deve ser realizada 

quando se pretende mostrar que peça fica por cima e que peça fica por baixo. A espessura deve estar de 

acordo com o tipo de material utilizado. Para isso selecione o nome da peça e preencha os campos de offset e 

espessura. Estas alterações podem ser feitas depois de definir cada peça ou no final.  

 

 
 

Note: 
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Edit pieces - define the edge type 

The edge type can be changed into a straight, rounded, semi-rounded or semi-rounded inverted one. 

Editarea tiparelor – Definirea marginilor 

Marginile pot fi de tipul: margine dreaptă, margine rotunjită, margine semi-rotunjită și margine semi-

rotunjită inversată. 

Editar piezas – Definir el tipo de canto 

Se puede cambiar el tipo de canto para que sea recto, redondeado, semi-redondeado o semi-redondeado 

invertido.  

Editar as peças - Definir o tipo de bordas 

É possível definir o tipo de borda como uma linha reta, arredondada, semi-arredondada ou semi-

arredondada invertida.  

 

 
 

Note: 
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Apply colours and textures to pieces 

In “Pieces” window go to “colours” tab. Here, you have a database of colours, materials and textures. Select 

pieces one by one, choose the colour/texture/material and left click on the piece. 

Aplicarea culorilor și a texturilor pe tipare 

Pentru aplicarea de culori și texturi tiparelor, se selectează fereastra “colours”din meniul “Pieces”. Tiparele 

sunt selectate unul câte unul și cu click stânga pot fi aplicate pe acestea  culorile/texturile/materialele dorite. 

Aplicar colores y texturas a las piezas 

En la ventana “Pieces/Piezas”, seleccionar la pestaña “colours/colores”. Aquí se pueden seleccionar los 

materiales, colores y texturas de la base de datos. Seleccionar las piezas una a una, escoger el 

color/textura/material y hacer clic con el botón izquierdo sobre la pieza para aplicarlo. 

Aplicar cores e texturas às peças 

Na janela "Pieces / Peças“ selecione “Colours / Cores“ com o botão esquerdo do rato. É possível selecionar 

materiais, cores e texturas a partir da base de dados. Selecione as peças uma por uma, selecione a cor / 

textura / material e clique com o botão esquerdo do rato sobre a peça onde pretende aplicar.  

 

 
 

Note: 
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Create lace holes – define element properties 

In “Pieces” window go to “Pieces contour and insides elements” tab. Select Insides>Circles>Linea 

Pinchazos, double click on it and a new window is opening, were you could define element properties, for 

example number of elements, distance between elements, width/radius, offset  etc. 

Definirea caracteristicilor perforațiilor de înșiretare 

Accesând fereastra “Pieces contour and insides elements”din meniul “Pieces” se urmărește succesiunea 

Insides>Circles>Linea Pinchazos. Prin dublu click pe ”Linea Pinchazos” se deschide o nouă fereastră unde 

pot fi definite caracteristicile perforațiilor de înșiretare, caracteristici precum numărul de perforații, distanța 

dintre perforații, diametrul/raza, distanțarea față de linia de bază etc. 

Crear ojetes – Definir propiedades de elemento 

En la ventana “Pieces/Piezas” ir a la pestaña “Piecescontour and insideselements/ Contorno de piezas y 

elementos interiores”. Seleccionar Insides> Circles> Linea Pinchazos/ Interiores>Círculoss>Línea 

Pinchazos, hacer doble clic sobre ello y se abrirá una nueva ventana en la que se pueden definir las 

propiedades del elemento, por ejemplo, el número de elementos, la distancia entre elementos, la 

anchura/radio, offset  etc. 

Criar ilhós - Definir propriedades dos elementos 

Na janela "Pieces / Peças" aceda ao separador "Pieces contour and insides elements / Contorno das peças e 

elementos interiores". Selecionar Insides>Circles>Linea Pinchazos / Interiores>Círculos>Linha punções, 

clique duas vezes e irá abrir-se uma nova janela na qual poderá definir as propriedades dos elementos, por 

exemplo, o número de elementos, a distância entre estes, a largura/raio, offset, etc. 
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Create lace holes – add element 

After defining element properties, select the outside quarter, hit “Add and edit element” and left click on 

the lace holes line. Apply the same steps for the laces holes of the inside quarter.  

Realizarea perforațiilor de înșiretare 

După definirea caracteristicilor orificiilor de înșiretare, se selectează unul dintre carâmbi, interior sau 

exterior, se lansează comanda “Add and edit element” și prin apăsarea click stânga pe linia orificiilor de 

înșiretare acestea sunt aplicate automat. Orificiilor de înșiretare sunt aplicate pe ambii carâmbi ai modelului. 

Crear ojetes – Añadir elemento 

Tras definir las propiedades del elemento, seleccionar la trasera exterior, pinchar en “Add and 

editelement/Añadir y editar elemento” y pinchar con el botón izquierdo sobre la línea de ojetes. Aplicar los 

mismos pasos para los ojetes de la trasera interior. 

Criar ilhós - Adicionar elementos 

Depois de definir as propriedades dos elementos, selecione a parte traseira exterior, clique em “Add and edit 

element / Adicionar e editar elemento" e clique com o botão esquerdo do rato sobre a linha dos ilhós. 

Aplicar os mesmos passos para os ilhós da parte interior.  

 

 
 

Note: 
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Add shoe laces 

Go to “Accessories” menu, select both inside and outside quarters, hit “Create Shoelace” button and select 

lace holes one by one to create the shoe laces and the shoe laces pattern.  

Aplicarea șireturilor 

Pentru aplicarea șireturilor se selectează ambii carâmbi ai modelului și din meniul “Accessories”, se 

lansează comanda “Create Shoelace”. Șireturile sunt aplicate automat după definirea modelului de 

înșiretare și a caracteristicilor înșiretării. 

Añadir cordones 

Ir al menú “Accessories/Accesorios”, seleccionar la trasera interior y exterior, pinchar en el botón 

“CreateShoelace/Crear cordón” y seleccionar los ojetes uno a uno para crear el patrón de acordonado.  

Adicionar atacadores 

Aceda ao menu "Accessories / Acessórios“, selecione a parte traseira interior e exterior, clique no botão 

"Create Shoelace / Criar atacadores" e selecione os ilhós um por um para criar o padrão dos atacadores.  

 

 
 

Note: 
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Add shoe laces 

Below you see the shoe lace in 3D and 2D views. 

Vizualizarea șireturilor 

Reprezentarea 2D și 3D a șireturilor nou create. 

Añadir cordones 

En la imagen de bajo se puede ver el cordón en la vista 2D y 3D.  

Adicionar atacadores 

Na imagem em baixo pode visualizar os atacadores em vista 2D e 3D.  

 

 
 

Note: 
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3D MODELLING OF BOTTOMS FOR MEN’S SHOE 

 
 Create insole 

 Create sole 

 Create heel 

 Apply colours and textures to bottom components 

 

MODELAREA 3D A ANSAMBLULUI  INFERIOR 

 
 Obținerea branțului 

 Obținerea tocului 

 Obținerea tălpii 

 Aplicarea culorilorși a texturilor pe componentele ansamblului inferior 

 

MODELADO EN 3D DEL PISO DE UN ZAPATO DE  

CABALLERO 

 
 Crear la planta 

 Crear la suela 

 Crear el tacón 

 Aplicar colores y texturas a los componentes del piso 

 

MODELAGEM EM 3D – COMPONENTES DO SOLADO 

 
 Criar a palmilha 

 Criar a sola 

 Criar o tacão 

 Aplicar cores e texturas aos componentes inferiores 
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3D MODELLING of BOTTOMS for Men’s Shoe 

To create the bottom pieces,  go to “Components” menu and define the component  type, by selecting 

“Create component type”. 

MODELAREA 3D A ANSAMBLULUI INFERIOR 

Pentru definirea și obținerea componentelor ansamblului inferior se va selecta opțiunea “Create component 

type”din meniul “Components”. 

MODELADO EN 3D DEL PISO DE UN ZAPATO DE CABALLERO 

Para crear las piezas del piso, ir al menú “Components/Componentes” y definir el tipo de componente, 

seleccionado el icono “Createcomponenttype/Crear tipo de componente”. 

Modelagem 3D – Componentes do solado 

Para criar os componentes inferiores de um sapato de homem, selecione "Components / Componentes". De 

seguida, para definir o tipo de componente selecione “Create component type / Criar tipo de componente". 

 

 
 

Note: 
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Create insole 

Step by step, the bottom components will be defined: the insole, the sole and the heel.  

In order to create the insole, select the bottom surface of the last and establish a value for its thickness (1 

mm). 

Obținerea branțului 

Se vor defini pas cu pas următoarele repere ale ansamblului inferior: branț, talpă și toc. 

Pentru obținerea branțului, se va selecta suprafața inferioară a calapodului și se va stabili grosimea dorită 

pentru acesta (de exemplu 1 mm). 

Crear la planta 

Paso a paso, se definen los componentes del piso: la planta, la suela y el tacón.  

Para crear la planta, se selecciona la superficie inferior de la horma y se establece el valor de espesor (1 mm). 

Criar a palmilha 

Passo a passo definem-se os componentes do solado: a palmilha, a sola e o tacão.  

Para criar a palmilha selecione a superfície da planta da forma e a sua espessura (1 mm).  

 

 
 

Note: 
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Create sole 

Define the sole by selecting the bottom surface of the last and giving the sole thickness.  

Obținerea tălpii 

Talpa este obținută după selectarea suprafeței plantare a calapodului și definirea grosimii acesteia. 

Crear la suela 

Definir la suela seleccionando la superficie inferior de la horma y dándole el espesor necesario. 

Criar a sola 

Para criar a sola selecione a superfície inferior da forma e atribua-lhe a espessura necessária. 

 

 
 

Note: 
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Create heel 

For creating a heel, select the bottom surface of the sole. Give values for heel height, also for its width and 

length.  The initial shape of the heel is pre-defined, and it could be modified. 

Obținerea tocului 

Tocul este obținut după selectarea suprafeței inferioare a tălpii și definirea caracteristicilor dimensionale, 

lungime, lățime și înălțime. 

Crear el tacón 

Para crear el tacón, se selecciona la superficie inferior de la suela. Se introducen los valores de altura de 

tacón, anchura y longitud. El tacón tiene una forma inicial predefinida que puede modificarse.  

Criar o tacão 

Para criar o tacão selecione a superfície inferior da sola e introduza os valores relativos à altura, largura e 

comprimento do tacão. O tacão terá uma forma inicial predefinida que poderá depois ser modificada.  

 

 
 

Note: 
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Apply colours and textures to bottom components 

To define the colours for bottom components, go to “Materials” tab, select the colour and then left click on 

each component to apply it. 

Aplicarea culorilor și a texturilor pe componentele ansamblului inferior 

Pentru definirea culorilor reperelor ansamblului inferior, se accesează meniul “Materials”, de unde se alege 

culoarea/textura dorită și se aplică pe fiecare reper. 

Aplicar colores y texturas a los componentes del piso 

Para definir los colores de los componentes del piso, ir a la pestaña “Materials/Materiales”, seleccionar el 

color y pinchar con el botón izquierdo sobre cada componente para aplicarlo.  

Aplicar cores e texturas aos componentes inferiores 

Para definir as cores dos componentes inferiores, aceda ao separador "Materials / Materiais", selecione a cor 

e clique com o botão esquerdo do rato em cada componente para executar a aplicação.  
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RENDERING 

 
 Define the environment type 

 The rendering process 

 Save the model picture 

5.  

 

PRELUCRARE GRAFICĂ 

 
 Definirea condițiilor de prelucrare grafică 

 Procesul de prelucrare grafică 

 Salvarea imaginii modelului 

5.  

 

RENDERIZADO 

 
 Establecer el tipo de escenario 

 Proceso de renderizado 

 Guardar la imagen 

 

 

RENDERIZAÇÃO 

 
 Definir o tipo de cenário 

 Processo de renderização 

 Guardar a imagem 
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Define the environment type 

The last stage is the rendering one. Open the “Render”  menu.  Here choose the type of shooting 

environment and set the rendering details. The method is similar to a professional picture shooting. After all 

rendering details are established, select “Render” and the process will start. 

Definirea condițiilor de prelucrare grafică 

Ultimul pas pentru obținerea modelului final de încălțăminte este cel de prelucrare grafică. Din meniul 

“Render” se aleg și se definesc tipul și detaliile prelucrării grafice. Metoda este similară unei sesiuni de 

fotografiere profesională. După ce sunt stabilite toate detaliile, se selectează opțiunea “Render” pentru 

începerea procesul de prelucrare. 

Establecer el escenario 

El último paso es el renderizado. Para ello, abrir el menú de “Render”.  Escoger el escenario deseado. El 

método es similar al de realización de una foto profesional. Cuando se hayan establecido todos los 

parámetros, clicar en “Render” y se iniciará el proceso.  

Definir o tipo de cenário 

O último passo é a renderização. Para isso aceda ao menu “Render". Escolha o cenário desejado. O método é 

similar ao da realização de uma fotografia profissional. Quando tiver definido todos os parâmetros, clique 

em “Render" e o processo terá início.  

 

 
 

Note: 
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The rendering process 

The rendering process requires some time that varies with the complexity of the model (lines, materials, 

ornaments etc.). The model becomes more realistic as  the  rendering process  is coming up to100%. 

Procesul de prelucrare grafică 

Procesul de prelucrare grafică necesită o anumită perioadă de timp ce variază în funcție de complexitatea 

modelului (linii, materiale, ornamente etc.). Modelul devine din ce în ce mai realist pe măsură ce procesul se 

apropie de final (100%). 

Proceso de renderizado 

La duración del proceso de renderizado dependerá de la complejidad del modelo (líneas, materiales, 

adornos, etc.). El modelo será más realista conforme el proceso vaya aproximándose al 100% de realización.  

Processo de renderização 

A duração do processo de renderização irá depender da complexidade do modelo (linhas, materiais, 

adornos, etc.). O modelo vai-se tornando mais realista à medida que o processo se vai aproximando dos 

100% de realização.  

 

 
 

Note: 
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Save the picture 

In this stage, the result can be saved as a picture. 

Salvarea imaginii 

După finalizarea de către aplicație a procesului de prelucrare grafică, rezultatul obținut poate fi salvat ca și 

imagine. 

Guardar la imagen 

El resultado se puede guardar como imagen.  

Guardar a imagem 

O resultado pode ser guardado como imagem.  

 

 
 

 

Note: 

 

 

 

 
 


